Notice: Although IconLogic makes every effort to ensure the accuracy and quality of these materials, all material is provided without any warranty.

Copyright: 1994-2012 by IconLogic, Inc., 3320 Breckenridge Way, Riva, MD, 21140, 410.956.4949. This document, or any part thereof, may not be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying, recording, storage in an information retrieval system, or otherwise, without the prior written permission of IconLogic.

Trademarks: IconLogic, Inc., and the IconLogic logo are registered trademarks of IconLogic. All companies and product names are trademarks or registered trademarks of their respective companies. They are used in this book in an editorial fashion only. No use of any trade name is intended to convey endorsement or other affiliation with IconLogic books.

Adobe Captivate 6: Beyond the Essentials
“Skills and Drills” Learning

Kevin A. Siegel
Contents
# About This Book

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Author</td>
<td>v</td>
</tr>
<tr>
<td>Book Conventions</td>
<td>vi</td>
</tr>
<tr>
<td>Confidence Checks</td>
<td>vi</td>
</tr>
<tr>
<td>Captivate System Requirements</td>
<td>vii</td>
</tr>
<tr>
<td>Acrobat.com</td>
<td>vii</td>
</tr>
<tr>
<td>Data Files</td>
<td>vii</td>
</tr>
<tr>
<td>Download the Windows Data Files</td>
<td>vii</td>
</tr>
<tr>
<td>Download the Mac Data Files</td>
<td>viii</td>
</tr>
<tr>
<td>How Software Updates Affect This Book</td>
<td>ix</td>
</tr>
<tr>
<td>Contacting IconLogic</td>
<td>ix</td>
</tr>
<tr>
<td>Special Thanks</td>
<td>ix</td>
</tr>
</tbody>
</table>

# Module 1: Essentials Review

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Review or Not to Review</td>
<td>2</td>
</tr>
<tr>
<td>Planning eLearning Projects</td>
<td>3</td>
</tr>
<tr>
<td>The Development Process</td>
<td>4</td>
</tr>
<tr>
<td>Resolution and Recording Size</td>
<td>7</td>
</tr>
<tr>
<td>Captivate's Recording Settings</td>
<td>8</td>
</tr>
<tr>
<td>Review Recording Settings</td>
<td>8</td>
</tr>
<tr>
<td>Access for Assistive Devices</td>
<td>11</td>
</tr>
<tr>
<td>Enable Access for Assistive Devices</td>
<td>11</td>
</tr>
<tr>
<td>Rehearsals</td>
<td>12</td>
</tr>
<tr>
<td>Rehearse a Script</td>
<td>13</td>
</tr>
<tr>
<td>Custom Recordings</td>
<td>14</td>
</tr>
<tr>
<td>Record a Custom Simulation</td>
<td>14</td>
</tr>
<tr>
<td>Text Caption Pre-Editing</td>
<td>20</td>
</tr>
<tr>
<td>Edit a Text Capture Template</td>
<td>20</td>
</tr>
</tbody>
</table>

# Module 2: Video Demos

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Video Projects</td>
<td>26</td>
</tr>
<tr>
<td>Record a Video Demo</td>
<td>26</td>
</tr>
<tr>
<td>Zooming and Panning</td>
<td>30</td>
</tr>
<tr>
<td>Zoom Closer to the Screen Action</td>
<td>30</td>
</tr>
<tr>
<td>Zoom Closer and Pan</td>
<td>32</td>
</tr>
<tr>
<td>Splitting</td>
<td>35</td>
</tr>
<tr>
<td>Split a Video</td>
<td>35</td>
</tr>
<tr>
<td>Trimming</td>
<td>37</td>
</tr>
<tr>
<td>Trim a Video</td>
<td>37</td>
</tr>
</tbody>
</table>

# Module 3: Custom Styles, Branching and Aggregating

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating Object Styles</td>
<td>40</td>
</tr>
<tr>
<td>Create a New Style</td>
<td>40</td>
</tr>
<tr>
<td>Apply a Style Globally</td>
<td>43</td>
</tr>
<tr>
<td>Export/Import a Style</td>
<td>44</td>
</tr>
<tr>
<td>Combining Projects</td>
<td>47</td>
</tr>
<tr>
<td>Name a Slide</td>
<td>47</td>
</tr>
<tr>
<td>Copy/Paste Project Assets</td>
<td>49</td>
</tr>
<tr>
<td>Branching</td>
<td>50</td>
</tr>
<tr>
<td>Use Buttons to Create a Branch</td>
<td>50</td>
</tr>
<tr>
<td>Explore the Branching View</td>
<td>52</td>
</tr>
<tr>
<td>Creating Groups</td>
<td>55</td>
</tr>
<tr>
<td>Create a Slide Group</td>
<td>55</td>
</tr>
<tr>
<td>Aggregating</td>
<td>57</td>
</tr>
<tr>
<td>Publish SWFs</td>
<td>57</td>
</tr>
<tr>
<td>Aggregate SWFs</td>
<td>59</td>
</tr>
</tbody>
</table>
## Contents

### Module 4: Question Pools
- Pools and Random Question Slides ........................................................... 62
- Insert a Question Slide ........................................................................... 62
- Rename and Create Question Pools ....................................................... 65
- Move Questions to Pools ....................................................................... 67
- Insert Random Question Slides ............................................................ 69

### Module 5: Accessible eLearning
- Accessibility and Captivate .................................................................... 72
- Set Document Information .................................................................... 73
- Enable Accessibility ................................................................................ 74
- Accessibility Text ................................................................................... 75
- Add Accessibility Text to Slides ............................................................ 75
- Import Slide Audio .................................................................................. 77
- Shortcut Keys ................................................................................................ 80
- Add Shortcut Keys .................................................................................... 80
- ClosedCaptioning .................................................................................... 83
- Add Closed Captions ............................................................................... 83

### Module 6: Variables and Widgets
- Variables .................................................................................................. 90
- Add Project Information ......................................................................... 90
- Insert a System Variable ......................................................................... 91
- Edit a System Variable ........................................................................... 93
- Create a User Variable ........................................................................... 95
- Use a Variable to Gather Data ............................................................... 96
- Widgets ...................................................................................................... 99
- Insert and Format a Widget ................................................................... 99
- Interactions ............................................................................................... 103
- Insert a Process Circle ........................................................................... 103

### Module 7: Actions
- Simple Actions .......................................................................................... 108
- Use a Completed Action ......................................................................... 108
- Name Objects ........................................................................................... 111
- Control Object Visibility ......................................................................... 113
- Create a Simple Action ........................................................................... 114
- Attach an Action to a Button ................................................................. 117
- Group Timeline Objects .......................................................................... 118
- Conditional Actions ................................................................................ 122
- Create a Variable .................................................................................... 122
- Create a Conditional Action ................................................................. 125
- MultipleDecisionBlocks .......................................................................... 129
- CreateDecisionBlocks ........................................................................... 129

### Module 8: Reviewing and Background Editing
- Collaborating ........................................................................................... 136
- Send a Project for Review ...................................................................... 137
- Add Review Comments .......................................................................... 139
- Review and Reply to Comments ............................................................ 144
- Background Editing ............................................................................... 149
- Create an Image Mask ............................................................................ 149
- IntegratingPhotoshop .............................................................................. 151
- Delete a Background ............................................................................... 151
- Work with PhotoshopLayers ................................................................. 152
Module 9: Master Slides, Themes and Templates

Master Slides ................................................................. 156
  Add an Image to a Master Slide ........................................ 156
  Insert a Content Master Slide ......................................... 157
  Apply a Master Slide to Project Slides............................... 158
  Edit a Master Slide ........................................................ 159
Themes .............................................................................. 162
  Apply a Theme ................................................................ 162
  Create a Custom Theme .................................................. 165
Project Templates ............................................................... 167
  Review an Existing Template .......................................... 167
  Create a Project from a Template .................................... 170
  Create a Project Template .............................................. 172
  Export/Import Project Assets .......................................... 175
Template Placeholders ...................................................... 176
  Insert a Placeholder ....................................................... 176

Module 10: Reporting Results

Acrobat.com as an LMS Alternative .................................... 178
  Enable Reporting .......................................................... 178
  Post Results to Acrobat.com .......................................... 180
  Use the Quiz Results Analyzer ....................................... 181
  Review and Chart Quiz Data ......................................... 183
LMS Reporting Options ..................................................... 184
  Set Quiz Reporting Options .......................................... 185
Manifest Files ..................................................................... 187
  Create a Manifest File ................................................... 187
Advanced Interaction .......................................................... 189
  Report a Button Interaction .......................................... 189
  Adjust Slide Object Interaction .................................... 190
Content Packages .............................................................. 191
  Publish a Content Package .......................................... 191
Uploading to an LMS .......................................................... 193
  Create an Inquisiq LMS Account .................................... 194
  Create an LMS Lesson .................................................. 196
  Create an LMS Course .................................................. 198
  Create an LMS Catalog ................................................ 200
  Test an eLearning Course .......................................... 202
About This Book

This Section Contains Information About:

- The Author, page v
- Book Conventions, page vi
- Confidence Checks, page vi
- Captivate System Requirements, page vii
- Data Files, page vii
- How Software Updates Affect This Book, page ix

The Author


Kevin spent five years in the U.S. Coast Guard as an award-winning photojournalist and has more than two decades experience as a print publisher, technical writer, instructional designer and eLearning developer. He is a certified technical trainer, has been a classroom instructor for more than 20 years and is a frequent speaker at trade shows and conventions.

Kevin holds multiple certifications from companies such as Adobe and CompTIA. You can reach Kevin at ksiegel@iconlogic.com.
Book Conventions

I believe that learners learn by doing. With that simple concept in mind, IconLogic books are created by trainers/authors with years of experience training adult learners. Before IconLogic books, our instructors rarely found a book that was perfect for a classroom setting. If the book was beautiful, odds were that the text was too small to read and hard to follow. If the text in a book was the right size, the quality of exercises left something to be desired.

Finally tiring of using inadequate materials, our instructors started teaching without any books at all. Years ago we had many students ask if the in-class instruction came from a book. If so, they said they’d buy the book. That sparked an idea. We asked students—just like you—what they wanted in a training manual. You responded, and the methodology is used in this book and every IconLogic training manual.

This particular book has been divided into several modules. Since each module builds on lessons learned in a previous module, I recommend that you complete each module in succession. During every module, you will be guided through lessons step by step. Instructions for you to follow will look like this:

☐ instructions for you to follow will look like this

If you are expected to type anything or if something is important, it will be set in bold type like this:

☐ type 9 into the text field

When you are asked to press a key on your keyboard, the instruction will look like this:

☐ press [shift]

I hope you enjoy the book. If you have any comments or questions, please see page ix for our contact information.

Confidence Checks

As you move through the lessons in this book, you will come across the little guy at the right. He indicates a Confidence Check. Throughout each module you will be guided through hands-on, step-by-step exercises. But at some point you’ll have to fend for yourself. That is where Confidence Checks come in. Please be sure to complete each of the challenges because some exercises build on completed Confidence Checks.
Captivate System Requirements

This book will teach you how to use Adobe Captivate version 6. The Adobe Captivate software does not come with this book. The software can be downloaded directly from Adobe (www.adobe.com/products/captivate.html). You do not need to purchase Captivate to learn Captivate. The trial version of the software can be downloaded from the link above. There are no limitations on the Captivate trial, and it will last for 30 days from the day you install it on your computer.

Here are Adobe’s system requirements for installing and using Adobe Captivate 6.

**Windows:** 1 GHz or faster processor Intel® Pentium® 4, Intel Centrino®, Intel Xeon®, or Intel Core™ Duo (or compatible) processor; Microsoft® Windows XP with Service Pack 3 or Windows 7 with Service Pack 1; 2GB minimum RAM (4GB recommended); 3GB of available hard-disk space for installation; and additional free space for the installation process (you cannot install on flash-based storage devices) 1024x768 display; (1280x1024 recommended) with 16-bit video card.

**Mac:** Multicore Intel® processor; Mac OS X v10.6 or v10.7; 2GB minimum RAM (4GB recommended); 3GB of available hard-disk space for installation; and additional free space for the installation process (you cannot install on a volume that uses a case-sensitive file system or on flash-based storage devices); 1024x768 display (1280x1024 recommended) with 16-bit video card.

Acrobat.com

You will use Acrobat.com during activities beginning on page 136. Acrobat.com is a free service, but you will need to create an account (visit www.acrobat.com), sign in and agree to the usage verbiage.

Data Files

You’re probably chomping at the bit, ready to dive into Captivate and begin creating eLearning lessons. Not so fast... do you have some sample projects to work with? What about graphics? Do you have some sound effects to play with? No? No worries. I’ve got everything you need—I call them data files—and they can be downloaded from the IconLogic website for free.

Windows users: Work through the following activity, and you will have your data files in no time. (Mac users, skip this activity and move to the next one.)

**Student Activity: Download the Windows Data Files**

1. Download the student data files necessary to complete the lessons presented in this book.
   - start a web browser
   - go to the following web address: http://www.iconlogic.com/pct.htm
   - click the **Captivate 6: Beyond the Essentials** link

   On most browsers, a dialog box will appear asking if you want to Save, Run or Open the file.

   - click the **Save** button and save the file to your desktop
2. After the file downloads, close the web browser.

3. Extract the data files.
   - find the **Captivate6BeyondData** file you just downloaded to your desktop
   - double-click the file to open it (it’s an EXE file containing the zipped data files)
   - confirm `C:\` appears in the **Unzip to Folder** area
   - click the **Unzip** button
   - click the **OK** button
   - click the **Close** button after the files have been extracted to your hard drive

The data files you will need for this book have now been installed to your hard drive (within a folder named **Captivate6BeyondData**). As you move through the lessons in this book, you will be working with these files.

*The next activity is only for Mac users. Windows users, review “How Software Updates Affect This Book” on page ix.*

**Student Activity: Download the Mac Data Files**

1. Download the student data files necessary to complete the lessons presented in this book.
   - start **Safari** (or other web browser)
   - go to the following web address: [http://www.iconlogic.com/mac.htm](http://www.iconlogic.com/mac.htm)
   - click the **Captivate 6: Beyond the Essentials** link

   The zipped data files will typically be downloaded to your **Downloads** folder and automatically extracted into a folder named **Captivate6BeyondData**.

2. Move the data files folder to your desktop.
   - drag the **Captivate6BeyondData** folder from the **Downloads** folder to your desktop

3. You can now close the **Downloads** folder window and web browser. Before starting the lessons in this book, it’s a good idea to review “How Software Updates Affect This Book” on page ix.
How Software Updates Affect This Book

This book was written specifically to teach you how to use Adobe Captivate version 6.0. At the time that this book was written, Captivate 6 was the latest and greatest version of the Captivate software available from Adobe.

With each major release of Captivate, my intention is to write a new book to support that version and make it available within 30-60 days of the software being released by Adobe.

From time-to-time, Adobe will make service releases/patches of Captivate available for consumers that fixes bugs or adds important functionality. For instance, I would expect Adobe to update Captivate 6 with a patch or two within a few months of Captivate 6 being released. That patched version might be called Captivate 6.01 or 6.1. Usually these updates are minor (bug fixes) and have little or no impact on the lessons presented in this book. However, every so often Adobe makes significant changes to the way Captivate looks or behaves, even with minor patches. (Such was the case when Adobe updated Captivate from version 5 to 5.5—about a dozen features were added, and a few panels were actually renamed, throwing readers of my books into a tizzy.)

Since it is not possible for me to recall and update printed books, it is possible that instructions you are asked to perform in this book will not match the patched/updated version of Captivate that you might be using. If something on your screen does not match what I am showing in the book, please visit the Captivate 6 Beyond Essentials product page on my website (http://iconlogic.com/captivate-6-beyond-essentials-workbook-adobe-iconlogic.htm). If an Adobe software update has altered something that will impact the lessons in this book, I will address the issues on that page (in the errata section) as soon as they are brought to my attention.

Contacting IconLogic

IconLogic, Inc.
3320 Breckenridge Way | Riva, MD 21140 | 410.956.4949
Web: www.iconlogic.com | E-mail: info@iconlogic.com

Special Thanks

I would like to thank some fine people for their help with this book.

Ellie Abrams (ellie@esatraininginc.com) offered her considerable proofreading skills to purge as many grammar errors from this book as possible.

AJ George, Patty Deluca, Barbara Ash, Jennifer Colwell, Douglas Desilets, Cindy Pandke and David Hadfield were beta-testing aces, helping ensure the accuracy of the lessons presented in this book.

Jill McGillen (www.nextturnconsulting.com) donated the projects you will aggregate during lessons beginning on page 57. Jill’s company, Next Turn Consulting, is a training company specializing in improving communication, leadership and results.

Lori Smith is IconLogic’s lead eLearning developer. Lori created the Advanced Actions activities you will work through beginning on page 108.
Rank Your Skills

Before starting this book, complete the skills assessment on the next page.
How this assessment works

Below you will find 10 course objectives for Adobe Captivate 6: Beyond the Essentials. **Before starting the book:** Review each objective and rank your skills using the scale next to each objective. A rank of 1 means No Confidence in the skill. A rank of 5 means Total Confidence. After you’ve completed this assessment, go through the entire book. **After finishing the book:** Review each objective and rank your skills now that you’ve completed the book. Most people see dramatic improvements in the second assessment after completing the lessons in this book.

**Before-Class Skills Assessment**

1. I can edit a Text Capture Template. 1 2 3 4 5
2. I can create a Slide Group. 1 2 3 4 5
3. I can aggregate published SWFs. 1 2 3 4 5
4. I can create Question Pools. 1 2 3 4 5
5. I can add Accessibility Text to slides. 1 2 3 4 5
6. I can create a background mask. 1 2 3 4 5
7. I can create a User Variable. 1 2 3 4 5
8. I can create a Master Slide. 1 2 3 4 5
9. I can create a Conditional Action. 1 2 3 4 5
10. I can create a Manifest File. 1 2 3 4 5

**After-Class Skills Assessment**

1. I can edit a Text Capture Template. 1 2 3 4 5
2. I can create a Slide Group. 1 2 3 4 5
3. I can aggregate published SWFs. 1 2 3 4 5
4. I can create Question Pools. 1 2 3 4 5
5. I can add Accessibility Text to slides. 1 2 3 4 5
6. I can create a background mask. 1 2 3 4 5
7. I can create a User Variable. 1 2 3 4 5
8. I can create a Master Slide. 1 2 3 4 5
9. I can create a Conditional Action. 1 2 3 4 5
10. I can create a Manifest File. 1 2 3 4 5
Module 1: Essentials Review

In This Module You Will Learn About:

- Planning eLearning Projects, page 3
- The Development Process, page 4
- Resolution and Recording Size, page 7
- Custom Recordings, page 14
- Text Caption Pre-Editing, page 20

And You Will Learn To:

- Review Recording Settings, page 8
- Enable Access for Assistive Devices, page 11
- Rehearse a Script, page 13
- Record a Custom Simulation, page 14
- Edit a Text Capture Template, page 20
To Review or Not to Review...

I’ve created this book as a companion to my *Adobe Captivate 6: The Essentials* book that I released in mid-2012. During the writing of that book, my goal was to get you up and running using Captivate 6 as quickly as possible. The finished book tipped the scales at over 200 pages. After completing that book, readers had a fair grasp of how to both record and produce eLearning lessons using Adobe Captivate. However, there was a ton of stuff that just wouldn’t fit into that book, nor was it appropriate to include many of those lessons into a beginner, or essentials, book.

In this book, I’m going to teach you many of the features and functions that I wasn’t able to cover in the *Adobe Captivate 6: The Essentials* book. But where to start? My assumption is that if you’ve purchased this book, you already have most of the essential Captivate skills under your belt. But that could be a very bad assumption. Maybe you’ve forgotten all of the cool stuff I taught you in that book. Maybe you’ve taught yourself Captivate and have skipped the *Adobe Captivate 6: The Essentials* book and have started with this book.

Again, I’ve got to ask this question: Where do I start? Instead of jamming the advanced concepts down your throat, let’s spend some time reviewing the essential information about Adobe Captivate, the production process, and then let’s use Captivate to record a video or two.

Some of the information you are about to read in this first module is taken directly from the first few modules in my essentials book, where I make a concerted effort to get you comfortable with the Captivate interface and recording modes.

Before you skip ahead to the second module, I urge you to read through this module and complete the activities... it will be well worth your time (especially when you get to the last few activities in the module, where I teach you how to pre-edit the text captions created when you record a lesson... something that is not taught in the *Adobe Captivate 6: The Essentials* book).

**What Is Adobe Captivate?**

Using Adobe Captivate, you can create eLearning lessons from just about anything you can access from your computer. The lessons you create can be interactive—you can add captions, rollovers, slidelets, clickable areas, typing areas, animation, Flash Video, widgets, variables, sound effects and more.

Captivate projects can be published as Small Web Format (SWF) files, HTML5, executable files, Word documents and PDFs. The published SWFs and HTML5 files will be cross-platform, meaning they can be viewed on just about any computer platform via a web browser (such as Chrome, FireFox, Internet Explorer or Safari).
Planning eLearning Projects

By the time you finish the last lesson in this book, you should be able to use Captivate to create some pretty compelling, technically sound eLearning lessons. However, just because you will soon be able to publish technically sound content does not necessarily mean you will go out and create good eLearning lessons. If you want to create good, useful lessons, you have to plan ahead. Before recording your first real video using Captivate, you should ask yourself the following questions:

- Who is my audience?
- What do I want my lessons to teach my audience?
- Is my audience young or old?
- What is the education level of my audience?
- Is my audience hearing challenged?
- Do I want my projects to contain images and background music? If so, where will I get them?
- Will there be captions (written instructions and descriptions)? If so, who will write the captions?
- Will I use a storyboard or script? (Storyboards are rough sketches that show the general content of your project, slide by slide. If your projects contain more screen shots of an application than captions, a storyboard is a good idea. Scripts, which are detailed step-by-step procedures, are ideal if your project will contain a significant number of captions.)
- Do I want my projects to be demonstrations, assessments or a combination of both?

When planning projects, keep in mind that the most useful lessons contain the following basic elements:

- Title slide (telling the audience what they are going to learn)
- Credits and Copyright slide
- Narration, music and other sound effects
- Images and animations
- Interactivity (click boxes, text entry boxes and buttons)
- An ending slide (reviewing what the audience learned)
The Development Process

I've listed the typical eLearning development process below. While not a complete list of the kinds of development challenges you'll need to keep in mind, the list includes a skill level number indicating the level of difficulty for each task. The numbers go from 1 to 10, with 10 indicating the most difficult task.

- **Write It**: If you’re not a writer, you’ll need someone to write the step-by-step instructions (also known as a script or storyboard) necessary to record the project in Captivate. You’ll typically find technical writers doing this kind of work, and I consider this the most important process. Without a good script, you don’t have a movie. Think I’m kidding? What do *Battlefield Earth, Barb Wire, Godzilla, Heaven’s Gate, Popeye* and *Ishtar* have in common? *(Skill Level: 10)*

- **Rehearse It**: Take the completed script and go through it with the software you'll be recording in front of you. Don't skip any steps. You'll be able to see if the steps you wrote are incomplete or inaccurate before you attempt to record the movie in Captivate. *(Skill Level: 2)*

- **Reset It**: After rehearsing the steps, be sure to “undo” everything you did. *(Skill Level: 1)*

- **Record It**: If rehearsals go well, so should the recording process. *(Skill Level: 1)*

- **Produce It**: This is where you use Captivate to add highlight boxes, captions, text entry fields, spell check, add buttons, click boxes, animation, question slides, audio, variables, advanced actions, etc. *(Skill Level: 8)*

- **Publish It**: Although not a difficult task, if your project is large (lots of slides and audio), publishing could take some time. You cannot do any work in Captivate while your project is publishing. *(Skill Level: 1)*

- **Post It**: This is a broad category. Posting your project will mean different things depending on where your finished lessons are supposed to go. For instance, if your lessons are supposed to end up inside a Learning Management System (LMS), you will have to set up the reporting features for your project, publish the project and then upload or install it into the LMS. After the lesson has been uploaded, you will need to test the lesson to ensure that it scores as expected. If you plan to simply add the lessons to your web server, posting may be as simple as using Captivate’s FTP feature to upload the lesson files. *(Skill Level: 2 or 3... or higher if your LMS is difficult to use)*

- **Test It**: This task isn’t difficult, but it could take time. If you find a problem, you’ve got to go back and fix it, publish the lesson and retest it. Some people argue that this step belongs above the Publish It process. I cannot argue with that logic. However, after testing the project, you’ll still need to publish it and, as I mentioned above, if you’re working with an LMS, upload it and test it again. Maybe it should be Test It, Publish It, Test It. See how easy I am? *(Skill Level: 2)*

- **Republish, Repost, Retest**: If something does not work when you test the posted version of your lesson, you’ll have to return to Captivate and fix the problem. After that, you’ll Publish, Post and Test again. Although this may not be a difficult process, it could take time. *(Skill Level: 2 or 3... or higher if you can’t resolve the problem)*
Budgeting Considerations

Many new Captivate developers underestimate the time needed to produce Captivate projects. The following table should help.

<table>
<thead>
<tr>
<th>Project Size</th>
<th>Number of Production Hours</th>
</tr>
</thead>
<tbody>
<tr>
<td>Small Projects (1-25 slides)</td>
<td>1-4 hours</td>
</tr>
<tr>
<td>Medium Projects (26-79 slides)</td>
<td>5-7 hours</td>
</tr>
<tr>
<td>Large Projects (80-150 slides)</td>
<td>8-10 hours</td>
</tr>
<tr>
<td>Bloated Projects (more than 150 slides)</td>
<td>Consider splitting projects this large into smaller projects.</td>
</tr>
</tbody>
</table>

I bet you’re wondering what “production” means, especially considering the fact that most of the projects you create will likely be in the large category (80-150 slides) and take you, on average, 10 hours to produce.

What Production Does Not Include

To begin, let’s consider what “production” does not include. As mentioned on page 3, you’ll need a script and/or storyboard.

- **Storyboards**: Rough sketches that show the general content of your project, slide by slide. If your projects contain more screen shots of an application than captions, a storyboard is a good idea.

- **Scripts**: Detailed step-by-step procedures. These are ideal if your project will contain a significant number of captions.

A typical one-hour eLearning course consists of 12, five-minute lessons. It could take up to three hours to write each of those lessons. Therefore, you should budget 40 hours to write the entire one-hour eLearning course. Depending on how fast you write, you could easily double those hours, meaning you may need to budget 80 hours for writing... which has nothing at all to do with Captivate production.

Production won’t include creating a Captivate template, a completed shell project that you will use as the basis of all of your projects. It’s not difficult to create a template, but it will take time. An ideal template will contain placeholders, an introduction slide, transitional slides, a conclusion slide, a skin and appropriate Start and End Properties (while these terms may seem foreign to you now, you will learn about many of them as you move through lessons presented in this book).

Finally, production does not include creating/recording the audio narration (voice-overs), making corrections to the script post-rehearsal, resetting the stage prior to recording, or recording the lessons using Captivate (the recording time should take the same amount of time as the process being recorded).

What Production Includes

So what’s left? As I mentioned on earlier, it’s going to take 10 hours (on average) to produce each Captivate project. What’s part of the production process?

You’ll spend a lot of time working with Text Captions. You’ll be adding interactive objects (click boxes, buttons, and text entry boxes. You’ll also likely be adding audio clips to the project’s background, individual slides and even objects on the slides.

During the production process, you’ll be publishing the project into any one of several output formats and possibly uploading those files to a server or Learning
Management System. You will be testing the lessons for scoring or interactivity errors. After that, you’ll need to fix problems you run across (and there will likely be plenty of problems that need to be fixed). After fixing those problems, you’ll need to republish, repost and then retest.

Add it all up, and your budget looks something like this (keep in mind that the timing below does not include the time it will take to record and edit your own voice-overs or narrations):

- 40-80 hours to write an eLearning script or create the storyboard to support 12, five-minute lessons for a one-hour course.
- 120 hours to edit, produce and test 12, five-minute lessons for a one-hour eLearning course.
- 40-80 hours to write a narration script to be used by your narrator.
- Up to 100 hours to record and enhance voice narration.

So there it is, a mere **380 hours** (give or take) is all that stands between you and your 60-minute eLearning course. Are you tired yet? No, not you... and not me. Here’s the deal: while creating eLearning lessons in Captivate takes a lot of work (likely more work than you thought prior to reading the past few paragraphs), the work will actually be fun, and rewarding. I’ve gotten great satisfaction watching students move through my eLearning lessons and learning. And I’ve had more fun creating eLearning than just about anything I’ve done in my career. I wish the same for you.
Resolution and Recording Size

During this module you will use Adobe Captivate to record a software simulation. During the recording process, you will perform a few commands on your computer, and provided Captivate is running and recording, every click you make with your mouse will result in one screen capture (also known as a screen shot).

Prior to recording, you should be aware of two things that control how sharp and how large your Captivate screen captures will be: Display Resolution and Recording Area.

Browser Wars

According to statistics compiled by www.w3schools.com/browsers/browsers_stats.asp, Google’s Chrome is the world’s most popular web browser; Firefox sits firmly in second place followed by Internet Explorer. I would encourage you to install each of the top browsers on your computer and test your eLearning lessons in all of them. If possible, I would also urge you to test your lessons on both PC and Mac operating systems to ensure the lessons perform as expected.

Display Resolution

A computer monitor (display) is measured in pixels, little squares that are the basic component of a computer graphic. Additional statistics offered by w3schools indicates that the trend in monitor display resolution is higher than 1024x768 pixels. If a monitor is set to show more pixels, it is known as increasing the resolution. At a higher resolution, graphics and text will look sharper, but smaller. The fewer pixels, the lower the resolution and the larger the screen elements appear.

If your computer is set to a high resolution (such as 1280x1024) when you record screen captures using Adobe Captivate, a learner viewing your published lesson on a display using a lower display resolution (such as 1024x768) may be forced to scroll significantly to see the action you recorded. Prior to recording screen actions, I’d suggest setting your computer display to the same resolution that you expect your learners to be using (or perhaps a slightly lower resolution). Of course, that doesn’t mean that you should set the resolution so low that your display looks terrible—use your best judgment. If you are creating eLearning lessons for internal employees, your corporate IT department will likely know the typical display resolution used on computers in your organization. If your lessons are intended for the public at large, you will need to take a best guess as to the typical display resolution your customers will be using. Of course, you could always survey your learners, but surveys may not be practical in your environment.

Recording Area

The Recording Area is not the same thing as Display Resolution (although the two settings are often confused). The Display Resolution is controlled via your computer’s Display settings. In contrast, the Recording Area is set from within Captivate and is the physical amount of the screen that you will be capturing during the recording process. There are several preset sizes available within Captivate, and you can specify your own.

I recommend a Captivate Recording Area of no larger than 800x600 if possible. If the expected target of your published lessons is an Apple mobile device, such as an Apple iPad, 1024x768 is Adobe’s suggested recording size.
Captivate’s Recording Settings

You will soon be recording a series of steps on your computer. Before that happens, you’ll need to review Captivate’s Recording Settings. For the most part, I’ll have you leave things set to the default (or have you reset the defaults). While not every option will be explained below, I’ll touch on several of the more important settings.

Student Activity: Review Recording Settings

1. Show Captivate’s Preferences and set the Language and Audio Options.

- Windows users, choose Edit > Preferences; Mac users, choose Adobe Captivate > Preferences

The Preferences dialog box opens.

- select the Recording category and then select Settings
- from the Generate Captions In area, ensure that English is selected from the drop-down menu

There are several languages available in the menu including German, Italian and Japanese. The language you select will control the text that is automatically created during the recording process.

- from the Audio Options area, deselect Narration, Actions in Real Time and Keystrokes (if necessary)

- from the Audio Options area, leave Camera Sounds checked

The Narration option allows you to record a narrator at the same time that you record the lesson.

If you select Actions in Real Time, Captivate will set the slide timing for your project slides to match the time it took you to complete a process. If you waited 10 seconds from one click to the next, Captivate would set your slide timing to match. I have never had a need to record Actions in Real Time. With Camera Sounds selected, you will hear a sound much like a camera shutter every time Captivate creates a screen capture. If you leave Keystrokes selected, Captivate will create an animation within your project that literally shows what you type, as you’re typing—typos and all.
2. Set the Hide options.

☐ Windows users, from the Hide area, deselect **Recording Window, Task Icon** and **System Tray Icon** (if necessary); Mac users, deselect **Recording Window** and **Dock Icon** (if necessary)

In the image below, the Windows options are shown at the left; the Mac options, at the right.

![Hide options](image)

If you had selected Recording Window, Task Icon (Dock Icon) and System Tray Icon, you would hide all evidence of Captivate during the capture process. These items would only get in the way if you were capturing your desktop and the Captivate application icon was on the screen. Since I tend to create software simulations within specific application windows, I typically leave these options deselected.


☐ from the Others area, ensure **Move New Windows Inside Recording Area** is selected

The **Move New Windows Inside Recording Area** option could prove useful if a window tried to appear outside of the Recording Area. Captivate will move the window into the Recording Area for you. Without this feature, you would have to pause the movie, drag the window into the Recording Area and continue. I typically enable this feature.

4. Enable Video recording.

☐ from the Smoothen movements for area, ensure both **Drag and Drop actions** and **Mouse Wheel Actions** are selected

These final two options deal with Video Demos. I cover Video Demos beginning on page 25.

5. Customize a recording key.

☐ from the **Recording** category at the left, select **Keys - (Global)**

☐ click in the **To Stop Recording** field and press the [y] key on your keyboard

The letter [y] replaces the key that was in the field by default.
If you were to move forward and record a lesson using Captivate, you would press [y] on your keyboard to end the recording process. You can customize the fields in this dialog box to suit your needs. For most people, the default keys work wonderfully.

6. Reset the default Recording Keys.
   - still in the Keys - (Global) area, click the Restore Defaults button
   - click the OK button

   When clicking the OK button, you might see the alert dialog box below.

   ![Alert Dialog Box]
   
   You cannot use a remote location as project cache folder. Please enter a valid location to continue.
   
   OK

   **Project Cache** is listed among the General Settings Preferences. Much like temporary Internet files created by web browsers as you surf the web, the Project Cache folder stores components of all of your projects until you click the Clear Cache button. The cached projects will make the process of re-opening, saving and working on projects faster than previous versions of Captivate (cache was introduced with Captivate 5.0).

   The Cache folder **cannot be located on a network drive** (which is considered a remote location). To resolve the issue presented in the dialog box above, select General Settings from the Preferences Category list at the left. From the Project Cache area, click the Browse button. Open your Local Disk and either select a folder on the disk or create a new one (I typically create a new folder called CpCache directly on the hard drive, but you can use any folder on your computer... as long as the folder is on the local disk). You should be able to click the OK button to get out of the Preferences dialog box.

   Since the Cache folder is updated as you work on projects, the Cache folder can get huge. It is a good idea to click the Clear Cache button once a month or so to free up disk space. It is possible to recover corrupt projects using assets found in the Cache folder. (See my blog for more information about that: iconlogic.blogs.com.) Once the cache is cleared, you will save disk space but lose the ability to recover corrupt projects using the Cache folder assets. Prior to clearing the Cache folder, ensure you have created a backup version of your project another hard drive.
Access for Assistive Devices

If you are using a Macintosh and attempt to record a video, you will likely run into a dialog box instructing you to Enable Access for Assistive Devices. To avoid the stress of seeing that dialog box just as you’re ready to record your first lesson, you must enable the feature.

Note: The following activity is for Mac users only (Windows users, you can move ahead to the “Rehearsals” activity that begins on page 12).

Student Activity: Enable Access for Assistive Devices

1. Enable access for assistive devices.
   - from the Apple menu, choose System Preferences
     The System Preferences window opens.
   - select either the System or Personal group (depending on the version of your Mac’s operating system, you will have either one or the other).
   - click the Universal Access button

The Universal Access window opens.

- from the bottom of the window, select Enable access for assistive devices

- close the Universal Access window

You are now ready to record.

2. Return to Adobe Captivate (if necessary).
Rehearsals

As mentioned on page 4, the Write It phase, or script development phase, is the most important and difficult part of the eLearning development process. After the Write It phase, you should rehearse the script to ensure that the script is accurate and every click you are expected to make during the recording process works as written.

Here’s the scenario for a series of recordings you are about to create: you have been hired to create an eLearning course that will teach new employees at your company how to use NotePad (Windows) or TextEdit (Macintosh). One of the lessons you plan to record using Captivate will include how to change the page orientation with Notepad or TextEdit.

Here is a sample script showing the kind of granular, step-by-step instructions you might create or receive from a Subject Matter Expert (SME). You are expected to perform each step below in either NotePad or TextEdit.

Dear Captivate developer, using either NotePad or TextEdit, record the process of changing the Page Orientation from Portrait to Landscape, and then back again (from Landscape to Portrait). I’d like you to create the recording using a capture size of 800x600. Thanks. Your pal, the Subject Matter Expert.

1. Click the File menu.
2. Click the Page Setup menu item.
3. Click the Landscape orientation button.
4. Click the OK button.
5. Click the File menu.
6. Click the Page Setup menu item.
7. Click the Portrait orientation button.
8. Click the OK button.
9. Stop the recording process.

The script sounds simple. However, you will not know what kind of trouble you are going to get into unless you step through the script prior to recording the process in Captivate. Let’s go ahead and run a rehearsal, just as if you were a big-time movie director and you are in charge of a blockbuster movie.

Places everyone... and quiet on the set...
Student Activity: Rehearse a Script

1. Minimize (hide) Captivate.

2. Start either Notepad (Windows) or TextEdit (Mac).

The process of starting either Notepad or TextEdit varies slightly depending on your operating system (Windows XP vs. Windows 7) and platform (Windows vs. Mac). If you are using Windows XP, choose Start > Run. Type notepad, and click the OK button. If you are using Windows Vista or Windows 7, choose Start, type notepad and press [Enter]. Finally, if you are using a Macintosh, choose Go > Applications. Locate and open TextEdit.

In the images below, Notepad is pictured at the left; TextEdit, at the right.

3. Rehearse the script.

☐ using either Notepad or TextEdit, click the File menu
☐ click the Page Setup menu item
☐ from the Orientation area, click Landscape

Note: In Notepad, Landscape is listed as the word “Landscape.” In TextEdit, Landscape is the second button (shown below).

☐ click the OK button
☐ click the File menu
☐ click the Page Setup menu item
☐ click the Portrait orientation button
☐ click the OK button

Hey, look at that! The script worked perfectly... no surprises. You are now ready to work the exact steps again. Only this time, you will record every click that you make. During the recording process, Captivate will create a screen capture each time that you click your mouse.
Custom Recordings

You can create software demonstrations or simulations using Captivate. Typical demonstrations include text captions that explain what’s about to happen, and then a mouse automatically moves across the screen to perform the action.

With a simulation, you can have text captions explaining a concept, just like a demonstration, but you can include interactive hotspots (click boxes) that will let the user actually perform the required steps.

Between demonstrations and simulations, I recommend you create simulations, especially if you are working by yourself and don’t have the resources to create both a demonstration and simulation for the same lesson. Why are simulations better? It’s always better to let a user perform the step-by-step process you’re trying to teach instead of allowing them to passively watch the steps.

When recording, I recommend you use Captivate’s Custom recording mode. This mode effectively combines Captivate’s Demonstration and Simulation modes. Using the Custom recording mode when you record, Captivate will automatically add text captions and click boxes throughout the lesson that will engage your learner.

Student Activity: Record a Custom Simulation

1. Set the Preferences for the simulation you are about to record.
   - leave Notepad or TextEdit running and return to Captivate
   - Windows users, choose Edit > Preferences;
     Mac users, choose Adobe Captivate > Preferences
   - from the Recording category, select Modes
   - from the Mode drop-down menu, select Custom
   - click the Restore Defaults button at the bottom of the dialog box
     By default, none of the options should be selected. By clicking the Restore Defaults button, any of the options that had been selected have now been deselected.
   - from the Captions area, select Add Text Captions
     None of the other options in the dialog box should be selected. You were asked to select Add Text Captions so that the Text Captions will be created for you. Nice. And, since the captions are written in the imperative, or as a command,
you may be able to use them in the new lesson with little editing. *Nicer.* Everything else has been left deselected except for **Click Boxes** and **Failure Caption**. These two settings will result in a highly interactive simulation. *Nicest!*

☐ click the **OK** button

2. Create a Software Simulation.

☐ from the Create New area of the Welcome Screen, click **Software Simulation**

On your computer display, notice two things besides Notepad or TextEdit. First, there is a large red box. This is the **Recording Area.** Second, there is a control panel containing Size and Recording Type areas.

3. Specify what Captivate is supposed to record.

Windows users, your instructions appear first. Mac users, your instructions appear after that.

☐ **Windows** users, from the top of the control panel, select **Application**

☐ from the **Select the window to record** drop-down menu that appears, select **Untitled - Notepad**

On your screen, notice that the red Recording Area and Notepad occupy the same space. By specifying Notepad as the Application, Captivate’s Recording Area is now focusing on Notepad.
Windows users, select Custom Size from the Snap to area

select **800 x 600** from the drop-down menu

The Recording Area resizes to 800 x 600. And since you selected Application, the Notepad application also resizes to 800 x 600.

I discussed the best size for your Recording Area on page 7. In reality, you should use the smallest Recording Size that works for you and the application or Screen Area that you are recording. Keep in mind that the smaller your recording area, the fewer megabytes your published video will be. The smaller the lesson, the faster your learners can consume your eLearning content.

Mac users, your instructions appear below. (Windows users, move to Step 4 on the next page.) Since Mac applications behave differently from Windows applications, Mac users won’t be able to use the Application or Snap To selections like Windows users. During the recording process, you will be including the Menu Bar as you change the Page Orientation within TextEdit. Since the Application option does not necessarily include the Menu Bar, you will need to manually specify a Screen Area to capture. If you are a Windows user, you should review Mac steps below in the likely event that you need to specify a Screen Area within an Application instead of the entire application.

Mac users, from the top of the control panel, select **Screen Area**

Mac users, ensure the **Set Capture Area to** is set to **Custom Size**

Mac users, select **800 x 600** from the drop-down menu
☐ Mac users, drag and resize the TextEdit window and the red Recording Area until your screen looks similar to the image below (notice that the TextEdit Menu Bar is encased within the red Recording Area)

4. Select the recording mode.

☐ All users, from the Recording Type area of the Control panel, select Automatic

With this option selected, every click of your mouse during the recording process will create a screen capture. In contrast, had you selected Manual mode, you would need to press a key on your keyboard (typically the [print screen] key for Windows users) to capture the screen.

☐ from the Recording Type area, select Custom

☐ deselect the other modes as necessary

☐ ensure that Panning is set to No Panning and that Audio is set to No Narration

5. Record screen actions.

☐ click the Record button and, once the Countdown goes away, use your mouse to click the File menu within Notepad or TextEdit

☐ click the Page Setup menu item

☐ from the Orientation area, click Landscape and then click the OK button

☐ click the File menu

☐ click the Page Setup menu item

☐ click the Portrait orientation button and then click the OK button
6. Stop the recording process using the **Stop Recording** key (discussed on page 10).

   **Note:** If the recording doesn’t end after pressing your Stop Recording keys, click the Captivate icon on the System Tray (Windows) or Dock (Mac).

7. Preview the project. (**File > Preview > Project**)

   As you move through the recording, notice that there are Click Boxes (hot spots) that make this lesson 100 percent interactive. Also notice that the Text Captions are written in the imperative to encourage interactivity. There may be one or two captions you would need to edit and some of the buttons are likely misnamed, especially on the Mac side. Nevertheless, much of the work is done.

8. When finished previewing the lesson, close the preview.

9. Close the project (there is no need to save it).
Confidence Check

You have been asked to bookmark a website so it can be accessed quickly in the future. The process of creating a bookmark (a Favorite) varies depending on the web browser you are using. For instance, if you are using Internet Explorer, you could choose the Favorites menu, click the Add to Favorites button and then click the Add button. If you are using Google Chrome, you could click the Bookmark button and then click the Add button. In Firefox, you could choose Bookmarks > Bookmark This Page. And finally, Mac users running Safari could show the Menu bar and then choose Bookmarks > Add Bookmark, and then click the Add button.

1. Using your browser of choice, use the Custom recording mode to create a video that simulates the process of creating a Bookmark (Favorite) for any website that you like.

Not sure how to proceed or what exactly to record? Use Captivate to open the project named Bookmarking.cptx (you can find it within the Captivate6BeyondData folder). Preview the project and you’ll see that I’ve created a video of the bookmarking process in each of the browsers mentioned above. You need to do the same in any browser you want. Forgotten how to record screen actions? See page 14.

2. When finished recording, save the new project to the Captivate6BeyondData folder as CreateFavorite.

3. Preview the project.

Notice that there are text captions and interactivity, which is wonderful. However, none of the captions contain end of sentence punctuation. While I am personally not a fan of end of sentence punctuation, many corporate style guides insist on end of sentence punctuation.

Believe it or not, it is possible to “pre-edit” the text captions and change, among other things, the text that actually appears in the captions and how Captivate treats end of sentence punctuation. You’ll delve into that next. This little bit of wizardry just might save additional hours of editing down the road.
Text Caption Pre-Editing

As you have just seen when you recorded a lesson using the Custom mode, Captivate created the text captions for you. Those captions were written in the imperative, which was great. However, there are a couple of ways to write an instruction. For instance, if you want to instruct a user to select the New command from a menu, here is how the instruction could be written:

1. Select the New menu item.
2. Choose the New command.

If you elected to go with the first option, you would be done because that’s the way Captivate automatically writes instructions when it creates the text captions. However, if you wanted to update the text caption to reflect the second option, you’d have to make the change manually. While not difficult, this kind of editing is very labor-intensive. And as I mentioned on the previous page, end of sentence punctuation is a debatable topic. Do you or don’t you? I don’t, but you might not agree.

To save a significant amount of text editing during post-production, you can pre-edit the text captions by editing one of the template files that are stored in the Captivate application folder on your hard drive. Captivate uses these files during the recording process when it creates the text captions.

Student Activity: Edit a Text Capture Template

1. Exit (Quit) Captivate.
2. Locate the file that controls the text that appears in automatic text captions.
   - navigate to the folder where Adobe Captivate 6 is installed on your computer (Windows users, the path is typically Program Files/Adobe/Adobe Captivate 6 (32 or 64 Bit); Mac users, Captivate is typically found in a folder named Adobe Captivate 6 directly within the Applications folder
   - find (but do not open) CaptureTextTemplates_English.rdl file

   This next step is possibly the most important. You are going to create a copy of the English rdl file. If you foul up the duplicate rdl file, no worries since you can simply throw it away. The changes you are about to make to the duplicate rdl file will have no impact on the original rdl file.

   - select the CaptureTextTemplates_English.rdl file and then copy and paste it into the Captivate 6 application folder (the current folder)

   **Note:** You may be prompted to confirm the action, which you should do. Since you are pasting a file directly within the application folder, not Captivate6BeyondData, you may be blocked completely because of limited read/write access to the application folder. In that case, you will need someone within your IT team to grant you read/write access to the Captivate 6 application folder on your computer. Otherwise, you will be unable to complete the remaining steps in this module.
4. Rename the duplicate rdl file.
   - change the name of the duplicate rdl file to
     `CaptureTextTemplates_YourFirstName.rdl`

Check for typos in your new file name. In the image below, notice that Biff has created an rdl file named `CaptureTextTemplates_Biff.rdl`. You will be editing your personal rdl file next.

![Image of file names]

5. Open `CaptureTextTemplates_YourFirstName.rdl` with **NotePad** (Windows) or **TextEdit** (Mac).
   - Windows users, right-click your rdl file and choose Open;
     Mac users, double-click your rdl file

If the file does not automatically open within NotePad (Windows) or TextEdit (Mac), you may need to lend a helping hand.

- Windows users, if a “Windows cannot open this file” dialog box (or similar) appears, choose **Select a program from a list of installed programs** and then click the OK button; Mac users, select **Choose Application**

![Windows dialog box]

The **Open With** dialog box (Windows) or **Choose Application** dialog box (Mac) will appear.
Windows users, select Notepad from the list of available programs and click OK; Mac users, select TextEdit.

In the images below, the Windows Open With dialog box is shown first, followed by the Mac’s Choose Application dialog box.

The rdl file will open in the text editor. If you are familiar with programming languages like HTML or XML, you will likely recognize the tags used in the document. If you do not have programming experience, no worries, you will be able to edit the template either way.

- scroll down to the part of the document shown below (if you have trouble finding the text, use the Find feature available in both Notepad and TextEdit to find **Object Name="Menu"**)

```xml
<Object Name="Menu" DefaultTemplate="Select the %s menu">
```

This is the part of the document that controls the words “Select” and “menu item.” If you edit the text in this part of the template, the automatic text captions created during the recording process will allow you to skip much of the editing process during the post-production phase. For instance, if you want the word **Choose** to appear in the text captions instead of **Select**, you’d need only change the word **Select** to **Choose**. And if you want each of the text captions to end with a period, all you’d need to do is add a period just to the left of the closing quote.

- at the end of the **Object Name="Menu"** line, click between the u in **menu** and the closing quote
- type a period

```xml
<Object Name="Menu" DefaultTemplate="Select the %s menu."/>
```

7. Save your work. (Keep the file open.)
Confidence Check

1. In the image below, I’ve added periods to the end of several lines of text. Spend a few moments adding periods on your own.

```
<Object Name="Menu" DefaultTemplate="Select the %s menu.">
  <Event Name="LeftDBClick" Template="Double-click the %s menu."/>
  <Event Name="RightClick" Template="Right Click the %s menu."/>
  <Event Name="RightDBClick" Template="Double-click the %s menu."/>
  <Event Name="MiddleDBClick" Template="Double-click the %s menu."/>
  <Event Name="KeyPress" Template="Press %s key for %s menu."/>
</Object>
<Object Name="MenuItem" DefaultTemplate="Select the %s menu item.">
  <Event Name="LeftDBClick" Template="Double-click the %s menu item."/>
  <Event Name="RightClick" Template="Right Click the %s menu item."/>
  <Event Name="RightDBClick" Template="Double-click the %s menu item."/>
  <Event Name="MiddleDBClick" Template="Double-click the %s menu item."/>
  <Event Name="KeyPress" Template="Press %s key for %s menu item."/>
</Object>
```

2. As an experiment, change the words **Select the %s menu item** to **Choose the %s command**. (During the recording process, let’s see if this has any effect on the text that appears in your text captions.)

3. Save and close the text file.

4. Return to Captivate and open Captivate’s **Preferences** dialog box.

5. Select the **Recording** category from the list at the left.

6. Select your name from the **Generate Captions In** drop-down menu.

```
Generate Captions In: English  Biff  Chinese-Simplified  Chinese-Traditional
```

7. Using your browser of choice, use the **Custom** recording mode to create another video that simulates the process of creating a Bookmark (Favorite) to any website you like. During the recording process, also select a menu or two and a menu item. (Need help recording screen actions using Custom mode? See page 14.)

8. When finished recording, save the new project to the **Captivate6BeyondData** folder as **CreateFavorite_CustomCaptions**.

9. Preview the project.

   The text captions should now contain end of sentence punctuation. In addition, if you used a menu when creating the Favorite, the text in the captions where you selected a menu command should now begin with **Choose** instead of **Select** and end with **command** instead of **menu item**.

   **Note:** You can use the original English rdl file at any time by simply choosing **English** from the **Generate Captions In** drop-down menu.